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Tantárgy: PROJEKTIRÁNYÍTÁS
Elõadó: Dr. Burány Nándor

6. szemeszter

1

III. RÉSZ   
EGYSZERÛ MINTA-PROJEKTEK

1. Felkészülés kirándulásra (forrás: www.ecch.com, 
készítették: Fraser Johnson és Robert Klassen)

2. Fészerépítés (forrás: www.k-
state.edu/infotech/epm/training/MSProject-
101, készítették Ashley Wondra, Lloyd Walker és
Chuck Gould)

3. Új utazási program bevezetése (forrás: Visoka 
�kola za projektni menad�ment, Beograd, 
www.vspm-bg.com)
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III-1 FELKÉSZÜLÉS KIRÁNDULÁSRA

1. Cél: egyszerû szoftveres projektterv 
(projektfájl, .mpp fájl) elkészítése, kritikus út 
tanulmányozása, átfutási idõ csökkentése.

2. A példa egyszerûsége a következõ dolgokban 
nyilvánul meg: 
� minden egy napon játszódik le
� egy erõforrás (ember) viszi végbe
� nem foglalkozunk a költségekkel. 

III-1.1 A PROJEKT LEÍRÁSA
Pista néhány napos sielést vett tervbe a vizsgaidõszak 
végén. Az utolsó vizsgáját elõreláthatólag pénteken 
12:00-kor fejezi be, ezt követõen kell felkészülnie az útra 
és el kell jutnia az autóbuszra, amely 17:00-kor indul. 
Az elmúlt napokat Pista tanulással töltötte, így nem 
tudott az elõkészületekkel foglalkozni. A vizsgát 
követõen haza kell hajtania a lakására, ez fél órát vesz 
igénybe. Ezt követõen  ki kell mosnia három töltés 
ruhát, ami összesen négy órát vesz igényben. A mosást 
követi a csomagolás, ez fél óráig tart, majd a kocsiba kell 
rakodni és a buszállomásra kell eljutni, ezek újabb fél-fél 
órát jelentenek. Idõközben el kell jutnia a bankba is 
pénzt felvenni, ehhez egy óra kell. 
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III-1.2 TEVÉKENYSÉGLISTA

TEVÉKENYSÉG JELE TEVÉKENYSÉG 
NEVE

A KÖZVETLEN 
ELÕZMÉNY

BECSÜLT ÁTFUTÁSI
IDÕ [h]

A hazahajt - 0,5

B kimossa a ruháit A 4,0

C becsomagol B 0,5

D elmegy a bankba A 1,0

E kocsiba rakja a 
dolgait

C,D 0,5

F elmegy az 
buszállomásra

E 0,5

ÚTMUTATÓ AZ 1. GYAKORLATHOZ: 
ÚJ PROJEKTFÁJL MEGNYITÁSA, 
MENTÉSE, ALAPBEÁLLÍTÁSOK 

ELVÉGZÉSE

1. Új szoftveres projektterv létrehozása és 
mentése.

2. Az alapbeállítások ellenõrzése és állítása 
(kötelezõen el kell végezni új terv 
létrehozásakor).

A szoftveres projektterv (projektfájl, .mpp fájl) 
különbözõ változatait gyakran kell menteni, 
nehogy információ-vesztés történjen!
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ÚJ PROJEKTFÁJL MEGNYITÁSA

� Kettõt kattintva az MS Project ikonjára 
indítsuk el a szoftvert!

� Szükség szerint zárjuk be a New Project és a 
Tasks ablakokat!

� A megnyíló üres projekttervet mentsük el a 
Save As paranccsal Felkészülés 
kirándulásra.mpp fájlnév alatt.

AZ IDÕSKÁLA BEÁLLÍTÁSA

� A Format|Timescale paranccsal nyissuk meg 
a Timescale ablakot!

� A Top Tier fülre kattintva, a Show opciót 
állítsuk Three Tiers-re!

� A Bottom Tier fülre kattintva a Units opciót 
állítsuk Minutes-ra, a Count opciót 30 
(percre)!

� A Middle Tier fülre kattintva állítsuk a Units 
opciót Hours-ra, a Count opciót 1-re! 

� Mentsük el a projektfájlt!
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1. gyakorlat: 
Új projektfájl megnyitása, mentése,  

alapbeállítások elvégzése

� Végezzük el a gyakorlatot!

9

ÚTMUTATÓ A 2. GYAKORLATHOZ:
A FELADATOK BEVITELE ÉS 

RENDSZEREZÉSE

1. A projektet alkotó feladatok bevitele az 
elõkészített projektfájlba.

2. A tevékenység-hosszak megadása.

3. A logikai függõségek definiálása.
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A FELADATOK BEVITELE

� Nyissuk meg a Felkészülés kirándulásra.mpp 
projektfájlt (ha még nincs nyitva).

� Válasszuk a Task Sheet View-t (nézetet). 

� A kapott táblázat Resource Name oszlopának 
elsõ sorába írjuk be: Hazahajt, majd nyomjuk 
meg az Enter gombot. 

� A következõ sorokba ugyanezzel az eljárással írjuk 
be a többi tevékenység elnevezését (Kimossa a 
ruháit, Becsomagol, Elmegy a bankba, Kocsiba 
rakja a dolgait, Elmegy a buszállomásra).

A TEVÉKENYSÉGHOSSZAK MEGADÁSA

� A Duration oszlopba a megfelelõ sorokba írjuk 
be a tevékenységhosszakat órákban, pl. a 
Hazahajt tevékenységnél írjunk be 0.5h-t, a 
Kimossa a ruháit tevékenységnél 4h-t stb. 
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A LOGIKAI FÜGGÕSÉGEK DEFINIÁLÁSA

� A Predecessor oszlopba írjuk be a közvetlen 
elõzmény sorszámát, pl. a Kimossa a ruháit 
tevékenység megfelelõ oszlopába írjunk 1-et, a 
Becsomagol tevékenységhez 2-t stb. A 
feladatok sorszáma a Task Sheet táblázat elsõ 
oszlopában található.

� Mentsük el a projektfájlt!

2. gyakorlat: 
A feladatok bevitele és 

rendszerezése

� Végezzük el a gyakorlatot!

14
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ÚTMUTATÓ A 3. GYAKORLATHOZ:
A KRITIKUS ÚT TANULMÁNYOZÁSA

1. Kritikus út a hálótervi diagramon.

2. Kritikus út a Gantt-féle diagramon.

A KRITIKUS ÚT A HÁLÓTERVI 
DIAGRAMON

� A View menüben nyomjuk meg a Network 
diagram gombot! Ezzel a hálótervi nézetre 
váltunk.

� Az alapbeállítás szerint a hálótervi diagramon 
a kritikus tevékenységek piros négyszöggel 
vannak jelölve. 

� A kritikus úton a logikai kapcsolatokat jelölõ 
nyilak is piros szinûek. 

� A nem kritikus tevékenységek négyszöge és 
nyila kék.
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KRITIKUS ÚT A GANTT-FÉLE 
DIAGRAMON

� Térjünk vissza a Gantt-féle diagramra (a View menüben nyomjuk 
meg a Gantt Chart gombot). Ha a tevékenységeket ábrázoló sávok 
nincsennek a látómezõben, kattintsunk a Scroll to task ikonra!

� A Format|Text Styles ablakban az Items to Change pontnál 
válasszuk a Critical Tasks  opciót, majd a Color pontnál a Red 
opciót! Az OK gomb megnyomásával zárjuk az ablakot! A 
táblázatban a kritikus úton levõ tevékenységek  nevei piros 
betûkkel lesznek írva.

� A Gantt-féle diagramon a kritikus úton levõ tevékenységek sávjai a 
Format|Gantt Chart Wizard varázsló alkalmazásával 
változtathatók pirosra.

� Ebben a feladatban nincsennek megkülönböztetve fõ- és 
altevékenységek, így minden tevékenység egyforma sávval van 
jelölve.

� Ízlés szerint kijelezhetjük a projekt összefoglaló tevékenységét: a 
Tools|Options ablakban válasszuk a View fület, majd kapcsoljuk be 
a Show project Summary task opciót!

3. gyakorlat: 
A kritikus út tanulmányozása

� Végezzük el a gyakorlatot!

18
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ÚTMUTATÓ A 4. GYAKORLATHOZ:
IGAZÍTÁSOK A PROJEKTTERVEN A 

HATÁRIDÕ TISZTELETBEN TARTÁSA 
ÉRDEKÉBEN

A felkészülési idõ az elkészített projektterv szerint 
hat órát vesz igénybe, viszont csak maximálisan öt 
óra áll rendelkezésre. Elvileg az átfutási idõ 
rövidítésére a következõ módszerek kínálkoznak:

1. Tevékenységek párhuzamos végzése.

2. A projekt terjedelmének csökkentése.

A TEVÉKENYSÉGEK PÁRHUZAMOS 
VÉGZÉSE

� A tevékenységek párhuzamos végzése közismert 
módszer a projekt átfutási idejének 
lerövidítésére. 

� A projekttervben már párhuzamosítva van az, 
amit párhuzamosítani lehetett (a bankügyletet 
addig végezzük, amíg a mosógép mos).

� A bankügyletre fordított idõ megfelezhetõ, ha 
felhívjuk a bankot és megkérjük, hogy készítsék el 
a szükséges iratokat. Sajnos ez nem rövidíti a 
projekt végrehajtási idejét, mert a bankügylet 
nem kritikus úton levõ tevékenység.
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A PROJEKT TERJEDELMÉNEK 
CSÖKKENTÉSE

� Kevesebb projektmunkát kevesebb idõ alatt 
végezhetünk el. 

� Ha három töltés ruha helyett kettõt mosunk ki, 
ezzel a mosási idõ a 2/3-ra csökkenthetõ (2 óra 40 
perc).

� Kattintsunk a Duration mezõre a Kimossa a ruháit 
tevékenység sorában és írjunk be a 4.0h helyett 
2.66h-t!

� Ezzel a kritikus út hossza kevesebb mint öt óra 
lett, ami megfelel a kitûzött határidõnek. 

4. gyakorlat: 
Igazítások a projektterven a határidõ 

tiszteletben tartása érdekében

� Végezzük el a gyakorlatot!

22
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A 2. PÉLDA 

(FELKÉSZÜLÉS KIRÁNDULÁSRA) 

VÉGE

III-2 FÉSZERÉPÍTÉS

1. Cél: egyszerû szoftveres projektterv 
elkészítése, az alapterv mentése, majd 
nyomonkövetés.

2. A példa egyszerûsége a következõ dolgokban 
nyilvánul meg: 

� kis számú feladat és erõforrás,

� egyszerû logikai függõségek,

� nincs szoros határidõ- és költség-keret.
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CÉLKITÛZÉSEK

A Fészerépítési projekttel kapcsolatos gyakolatok a 
következõ mûveletek végzésére képezik ki a hallgatót:
� a projektdokumentáció (szoftveres projektterv) 

szabályos létrehozása,
� a feladatok bevitele,
� a feladatok hosszának bevitele,
� logikai függõségek definiálása a feladatok között,
� erõforrások hozzárendelése a feladatokhoz,
� a bázisterv mentése,
� a projekt irányítása és a végrehajtás nyomon 

követése.
25

A PROJEKTFELADAT LEÍRÁSA

� Szükségünk van egy fészerre, ahová 
elhelyezhetjük a kerti szerszámainkat és 
felszereléseinket, amelyeket eddig a garázsban 
tartottunk. 

� A fészert a Home Depot cégtõl vásárolt kész 
alkatrészekbõl fogjuk megépíteni.
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A PROJEKTTERJEDELEM (IGÉNYEK) 
MEGHATÁROZÁSA

� A falak legyenek 8 ft (láb) magasak; az alapterület 120 sq. 
ft (négyzetláb),  az ablakok az épület minden oldalán 
legyenek 2ftx3ft méretûek.

� A bejárati ajtó legyen 7ftx8ft, tervezzünk rá zárat.
� A fészert borítsuk ugyanazzal az anyaggal, mint a háztetõt, 

hogy jól illjen a házhoz. Ugyanez vonatkozik a falakra is.
� A kilógó szarufa végeket ne vágjuk le, ezek alatt további 

raktározási helyet nyerünk. A padlózat legyen betonból.
� A helyszín: a délnyugati sarok az udvar hátsó részében.
� A munkálatok becsült értéke 1.250$.
� A munkálatok becsült idõtartama: egy hónap (azzal, hogy 

csak csütörtökön és pénteken dolgozunk).

AZ EMBERI ERÕFORRÁSOK

� Andy Handy � külsõ munkaerõ, a bére 25$ 
óránként,

� Betty Doe (a tulajdonos lánya) � a bére 10$ 
óránként,

� Frank Doe (a tulajdonos fia)  � a bére 10$ 
óránként,

� John Doe (a tulajdonos) � a bére 0$ óránként.
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A TERV LÉPÉSEKRE BONTVA - 1
� Az alkatrészek megrendelése és a leszállítás megbeszélése (az 

elsõ héten)
� Hossz: 1 nap, munkaórák: 2, munkás: John
� Elõkészítés (összefoglaló feladat)
� A terep elõkészítése � a terület megtisztítása és elegyengetése 

(az elsõ héten)
� Hossz: 2 nap, munkaórák: fejenként 12, munkások: Betty, 

Frank, John
� A betonalap megöntése  (a második héten)
� Hossz: 1 nap, munkaórák: fejenként 5, munkások: John, Andy
� Az alkatrészek átvétele
� Hossz: 1 nap, munkaórák: 2, munkás: John
� Az alkatrészek átvétele mint mérföldkõ
� Hossz: 0 nap, munkaórák: 0, munkás: senki

A TERV LÉPÉSEKRE BONTVA - 2

� Összeszerelés (összefoglaló feladat)

� Összeszerelés ( a harmadik héten)

� Hossz: 1 nap, munkaórák: fejenként 5, munkások: John, Andy

� A fészer festése

� Hossz: 1 nap, munkaórák: fejenként 2, munkások: Frank, 
Betty

� Füves területek/virágágyások rendezése

� Hossz: 1 nap, munkaórák: 4, munkás: Betty

� A szerszámok és felszerelések elhelyezése a kész fészerben. (a 
negyedik héten)

� Hossz: 1 nap, munkaórák: fejenként 5, munkások: John, Frank
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ÚTMUTATÓ AZ 1. GYAKORLATHOZ: 
PROJEKTFÁJL MEGNYITÁSA, MENTÉSE, 

ALAPBEÁLLÍTÁSOK ELVÉGZÉSE
1. Új szoftveres projektterv létrehozása és 

mentése,
2. Beállítások a Project Information ablakban,
3. Az alapbeállítások ellenõrzése és állítása 

(kötelezõen el kell végezni új terv 
létrehozásakor),

4. Új oszlopok hozzáadása a táblázatokhoz.
A szoftveres projektterv (projektfájl, .mpp fájl) 
különbözõ változatait gyakran kell menteni, 
nehogy információ-vesztés történjen!

A Project Information ablak 
(Project Information dialog box)

32
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Alapbeállítások
(Tools → Options), Schedule lap

33

Alapbeállítások, 
View lap

34
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Projektnaptárak 
(Tools→Change Working Time)

35

Nézet (View) kiválasztása és oszlop hozzáadása

� Task Sheet nézet (View → More Views → Task Sheet 
view),

� oszlopok megjelenítése és eltüntetése szükség szerint,

� a következõ oszlopok megjelenítése tanácsos:

� a feladat neve (Task Name)

� a feladat elvégzettségének szintje (% Complete)

� a feladat hossza, becsült idõtartama (Duration),

� a tervezett munka mennyisége (Work),

� kezdõ dátum (Start),

� befejezési dátum (Finish),

� erõforrások (Resources).
36
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1. gyakorlat: Projektfájl megnyitása, 
mentése, alapbeállítások elvégzése

� Végezzük el a gyakorlatot!

37

ÚTMUTATÓ A 2. GYAKORLATHOZ:
A FELADATOK BEVITELE ÉS 

RENDSZEREZÉSE

1. A projektet alkotó feladatok bevitele az 
elõkészített projektfájlba,

2. A bevitt  feladatok rendszerezése 
(összefoglaló feladatok, közönséges feladatok 
meghatározása).
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A feladatok (tevékenységek) rendszerezése

� fõ összefoglaló tevékenység (magába foglalja 
az egész projektet),

� összefoglaló tevékenységek (a projektmunka 
jelentõsebb fázisai),

� altevékenységek (konkrét tevékenységek),
� a feladatok viselkedése az erõforrások 

hozzárendelésekor (tevékenységtípusok): a
munkamennyiség-, az erõforrások száma- és a 
feladathossz közötti összefüggés.

39

A fõ összefoglaló tevékenység

� A fõ összefoglaló tevékenység jellemzõi:

� ID = 0

�Unique ID = 0

�Outline Level = 0 

� Summary = Yes

� Csak a fõ összefoglaló tevékenység lehet
Outline Level = 0 szinten.

40
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Összefoglaló tevékenységek

41

Altevékenységek

42
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Tevékenységtípusok:
A munkamennyiség-, az erõforrások száma- és a 

feladathossz közötti összefüggés
� Állandó erõforrás mennyiségû (Units) tevékenység � adott 

mennyiségû erõforrással végzett feladatok, a munka 
mennyisége (Work) és a tevékenységhossz (Duration) nem hat ki 
az erõforrások mennyiségére (számára).

� Állandó munkamennyiségû tevékenység � a munka 
mennyisége nem függ a feladathossztól és az 
erõforrásmennyiségtõl.

� Állandó feladathosszú tevékenység (javasolt alapbeállítás) � a 
feladathossz  (az elvégzés ideje) nem függ a munkamennyiségtõl 
és az erõforrásmennyiségtõl.

� Munkamennyiség-alapú tevékenység  � a feladathossz változik 
az erõforrásmennyiség változtatásakor, de a munkamennyiség 
állandó marad.

43

A tevékenységtípus megadása

44
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2. gyakorlat: A feladatok bevitele és 
rendszerezése

� Végezzük el a gyakorlatot!

45

ÚTMUTATÓ A 3. GYAKORLATHOZ:
A TEVÉKENYSÉGEKRE VONATKOZÓ 
TOVÁBBI INFORMÁCIÓK BEVITELE

1. Korlátok beállítása,

2. Tevékenységhosszak megadása,

3. Logikai függõségek kézi beállítása,

4. Logikai függõségek beállítása több feladatnál 
egyidõben,

5. A logikai függõségek finomítása késések 
hozzáadásával.
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A tevékenységekre vonatkozó 
információk

Adatbevitel és beállítások a Task Information
ablakban:

� mérföldkövek felvétele,

� tevékenységhosszak bevitele,

� korlátok megadása,

� a tevékenységek közötti logikai függõségek 
megadása.

47

Task Information ablak, 
General lap

48
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Task Information ablak, 
Predecessors lap

49

Task Information ablak, 
Resources lap

50
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Task Information ablak, 
Advanced lap

51

Task Information ablak, Notes lap: 
feljegyzések készítése

52
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Task Information ablak, 
Advanced lap: mérföldkövek felvétele 

(Milestone)

53

A várható tevékenységhossz

� Task Sheet ablak, General lap,
� A tervezés során a tevékenységhossz

(Duration) bevitelekor, a feladat elvégzéséhez 
szükséges várható (tervezett) idõt írjuk be.

� A lehetséges idõegységek:
� m = perc,
� H = óra,
� D = nap,
� W = hét,
� M = hónap.

54
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A tevékenységek elvégzésére vonatkozó 
idõkorlátok

� Task Sheet ablak, Advanced lap, Constraints cella,
� A korlátok (Constraints) típusai:
�minél késõbb kell elkezdeni (as late as possible),
�minél hamarabb kell elkezdeni (as soon as possible),
� ne fejezõdjön be hamarabb mint (finish no earlier than),
� ne fejezõdjön be késõbb mint (finish no later than),
� a megadott dátummal kell befejezõdnie (must finish on),
� a megadott dátummal kell elkezdõdnie (must start on),
� ne kezdõdjön el hamarabb mint (start no earlier than),
� ne kezdõdjön késõbb mint (start no later than).

55

Logikai függõségek a tevékenységek 
között

� Task Information ablak, Predecessor lap, Type cella,
� A logikai függõségek (kapcsolatok) fajtái:
�befejezés-kezdés kapcsolat (FS - finish to start, ez 

az alapbeállítás, ezt használjuk leggyakrabban),
� kezdés-befejezés kapcsolat (SF - start to finish),
� kezdés-kezdés kapcsolat (SS - start to start),
�befejezés-befejezés kapcsolat (FF - finish to 

finish).

56



4/14/2009

29

3. gyakorlat: A tevékenységekre 
vonatkozó további információk 

bevitele

� Végezzük el a gyakorlatot!

57

ÚTMUTATÓ A 4. GYAKORLATHOZ:
AZ ERÕFORRÁSOK BEVITELE

1. Az erõforrás nevének beírása,

2. Az erõforrás típusának meghatározása,

3. Költségek rendelése az erõforrásokhoz,

4. Erõforrások rendelése a feladatokhoz,

5. A becsült tevékenységhosszak bevitele.
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Erõforrások

� az erõforrások fajtái,

� az erõforrások bevitele,

� erõforrások rendelése a feladatokhoz 
(tevékenységekhez),

� a "munka" (munkamennyiség) fogalma.

59

Az erõforrások fajtái
� munka típusú erõforrás (emberek vagy 

csoportok),
� eszközök (munkagépek, számítógép hardver, 

helyiségek...),
A két fenti típust az MS Project munka (Work) 
típusként kezeli
� anyagok (Material) (a projekt végrehajtása 

közben fogyó anyagok),
� költségek (Cost) (utiköltségek vagy más, ami nem 

közvetlenül a projekt végrehajtásával 
kapcsolatos, de költséggel jár).

60
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Az erõforrások bevitele
� akkor tanácsos az erõforrások bevitele, ha már a 

feladatokat bevittük és logikai függõségeiket 
meghatároztuk,

� nevet kell adni (Resource Name) és meg kell 
határozni a menyiséget (Units) minden 
erõforrásnál,

� a tevékenységhossz (Duration) a tervezett idõ  
napokban kifejezve, amely alatt a tevékenység 
elvégezhetõ,

� a munkamennyiség (Work) a feladat elvégzésre 
fordított erõfeszítés mennyisége, órákban 
kifejezve. 61

4. gyakorlat: Az erõforrások bevitele

� Végezzük el a gyakorlatot!

62
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ÚTMUTATÓ A 5. GYAKORLATHOZ:
A BÁZISTERV MENTÉSE ÉS A 

TÉNYLEGES ÉRTÉKEK BEVITELE

A projektterv elkészítésével a projekt 
szervezése nem fejezõdött be.

A további teenndõk:

1. A bázisterv mentése

2. A projekt nyomon követése

A projekt végrehajtásának nyomon 
követése (Tracking)

� a bázisterv mentése,

� a tényleges elõrehaladásra vonatkozó 
információk bevitele.

64



4/14/2009

33

A bázisterv mentése

� a bázisterv mentésének célja,

� hogyan végezzük?
� Tools → Tracking → Save Baseline

� be kell kapcsolni az Entire project opciót!

65

A tényleges elõrehaladásra vonatkozó 
információk bevitele

� nyissuk meg a Task Sheet ablakot,

� vigyük be a tényleges kezdés dátumát,

� szüntessük meg a felesleges korlátokat,

� vigyük be a tevékenység tényleges hosszát,

� igazítsuk a tevékenység elvégzettségének fokát 
100%-ra,

� lényeges, hogy az adatokat milyen sorrendben 
visszük be.

66
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5. gyakorlat: A bázisterv mentése és a 
tényleges értékek bevitele

� Végezzük el a gyakorlatot!

67

ÚTMUTATÓ A 6. GYAKORLATHOZ:
NÉZETEK, TÁBLÁZATOK, SZÛRÕK

� a leggyakrabban alkalmazott nézetek (Views):

� Task View nézet,

�Gantt Chart nézet,

� Tracking Gantt nézet,

� saját szerkesztésû nézetek.

� táblázatok (Tables),

� szûrõk és csoportok (Filters, Groups).
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Task Sheet nézet

� gyakran alapul szolgál más nézeteknek,

� jól alkalmazható saját szerkesztésû nézeteknél.

69

Gantt Chart nézet

70
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Tracking Gantt nézet

71

Saját szerkesztésû nézetek

� A nézetek a következõ elemeket tartalmazzák:
� táblázatok,

� szûrési eredmények,

� csoportok.

� Tanácsos  másolni és új név alatt elmenteni a 
saját szerkesztésû nézeteket és a velük 
kapcsolatos szûrõket és csoportokat.

72
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Táblázatok

� Adatok bemutatása oszlopokba és sorokba 
rendezve.

� Szerkesztési információkat is õriz a szoftver a 
táblázatokra vonatkozóan.

73

Szûrõk és csoportok

� A szûrõk - lehetõvé teszik a tevékenységek 
részhalmazának kiválasztását és 
megjelenítését.

� A csoportok - a sorokat tudják átszervezni a 
tartalmuk alapján.

� A szûrõket és csoportokat használhatjuk 
együtt is és külön-külön is.

� Szûrõk és csoportok létrehozásakor 
használhatunk egy vagy több feltételt.

74
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6. gyakorlat: Nézetek, táblázatok, 
szûrõk

� Végezzük el a gyakorlatot!

75

A 2. PÉLDA

(FÉSZERÉPÍTÉS)

VÉGE
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III-3 ÚJ UTAZÁSI PROGRAM 
BEVEZETÉSE

1. Cél: Röviden bemutatni egy olyan színvonalú 
projekttervet, amilyen a vizsgamunka kell hogy 
legyen.

2. A példa egyszerûsége a következõ dolgokban 
nyilvánul meg: 
� kis számú erõforrás dolgozik a projekten (3+)
� a költségkeret nincs pontosan meghatározva 

(korlátozva).
� nem használunk semmi jelentõs felszerelést.

III-3.1 A PROJEKT LEÍRÁSA
� A Follow me � NIS Jugopetrol tourism utazási iroda 

vezetõsége a piackutatás eredményeinek felhasználásával 
arra a megállapításra jutott, hogy a meglévõ kínálatok mellé 
új utazási programot kell felvenni. Úgy határoztak, hogy az 
új projekttel a fiatalokat célozzák meg. A fiatalok nagy 
érdeklõdésével összhangban a legvonzóbb útirányként  a 
Franciaország - Spanyolország - Olaszország vonalat jelölték 
meg. 

� Az új utazási program bevezetésével kapcsolatos célok, 
határidõk, összetettség, erõforrások, munkalebontási 
szerkezet és a munka terjedelme olyan szintûek, hogy ezt a 
munkát projektnek tekintjük. Ez az eset miatt és tekintettel 
a további fejlesztési tervekre, az utazási iroda bevezeti a 
projektirányítást a munkába. 
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III-3.2 A PROJEKT CÉLJAI -
SIKERKRITÉRIUMOK

� 1. cél � A projekt befejezése 2007. nov. 11-re.

� 2. cél � Az új utazási program bevezetése az 
állandó kínálat részeként.

� 3. cél � Kapcsolatok megteremtése külföldi 
partnerekkel és szerzõdéses viszony kialakítása  
velük.

� 4. cél � A projekt megvalósítása megfelelõ 
költségvetésen belül.

III-3.3 MUNKALEBONTÁSI RENDSZER-
WBS DIAGRAM
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III-3.4 A PROJEKT FELADATAI - AZ 
ELÕKÉSZÜLETEK ÖSSZEFOGLALÓ FELADAT

1. Elõkészületek

1.1. Az indokoltság kiértékelése

1.2. Ötletterv

1.2.1. Az elvárások pontosítása

1.3. Az alapok kidolgozása

1.3.1. A célok meghatározása

1.3.2. A kritériumok meghatározása

1.3.3. A terjedelem meghatározása

III-3.5 A PROJEKT FELADATAI - A 
LOGISZTIKA ÖSSZEFOGLALÓ FELADAT

2. Logisztika
2.1. Kapcsolat felvétele a nagykövetségekkel
2.2. Szállodák felderítése

2.2.1. Információk gyûjtése a szállodákról
2.2.2. A számításba jövõ szállodák kiválasztása
2.2.3. Kapcsolatok felvétele a szállodákkal

2.3. Szállítóvállalat felderítése
2.3.1. Információk gyûjtése a szállítókról
2.3.2. A szállító kiválasztása
2.3.3. Kapcsolat felvétele a szállítóval

2.4. Vízumok beszerzése
2.5. Szállodák biztosítása

2.5.1. Helyfoglalás
2.5.2. Szerzõdéskötés a szállodákkal

2.6. Szállító biztosítása
2.6.1. Szállító lefoglalása
2.6.2. Szerzõdéskötés a szállítóval
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III-3.6 A PROJEKT FELADATAI -
A PROGRAMKÉSZÍTÉS ÖSSZEFOGLALÓ 

FELADAT

3. Programkészítés

3.1. Az utazás idõpontjának kijelölése

3.2. Az útvezetõ kinevezése

3.3. Szabad programok meghatározása

3.4. Személyzet biztosítása

III-3.7 A PROJEKT FELADATAI -
A VÉGREHAJTÁS ÖSSZEFOGLALÓ FELADAT

4. Végrehajtás
4.1. Az új utazási program piacra dobása

4.1.1. A marketing stratégia kialakítása
4.1.2. Reklámanyag készítése
4.1.3. A marketing stratégia kivitelezése
4.1.4. Bemutató tevékenységek
4.1.5. Az érdekeltek kikérdezése

4.2. Az új utazási program kivitelezése
4.2.1. Az utasok nyilvántartásba vétele
4.2.2. Az indulás megszervezése
4.2.3. A jóváhagyott terv végrehajtása
4.2.4. A visszautazással kapcsolatos kötelezettségek rendezése

4.3. Operatív jelentések készítése
4.3.1. Az eredemények együttes megjelenítése
4.3.2. A dokumentáció átadása
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III-3.9 A PROJEKT MÉRFÖLDKÖVEI

SORSZÁM MÉRFÖLDKÕ TERVEZETT IDÕPONT

1. Megkaptuk a jelentést az indokoltság kiértékelésérõl 2004.11.22.

2. Aláírtuk a szerzõdéseket  a szállodákkal 2005.02.01.

3. Aláírtuk a  szerzõdéseket a szállítókkal 2005.02.07.

4. Az utazás programja elkészült 2005.03.01.

5. A kivitelezési fázis elkezdõdött 2005.03.11.

6. Az elsõ utazásban érdekeltek  bejelentkeztek 2005.04.15.

7. Megkaptuk a vízumokat 2005.04.18.

8. Megkezdõdött az elsõ utazás 2005.04.26.

ÚTMUTATÓ AZ 1. GYAKORLATHOZ:
A BÁZISTERV ELEMZÉSE

� Nyissuk meg a Follow me - Bázisterv projektfájlt!
� Nézzük meg, mely információk vannak megjelenítve a 

Gantt-féle nézet táblázatos részében!
� A Gantt-féle diagramon vegyük szemre az összefoglaló 

feladatokat, a közönséges feladatokat, a logikai 
összefüggéseket és a mérföldköveket!

� Project|Filtered for|Summary tasks paranccsal rejtsük el a 
közönséges feladatokat (hogy csak az összefoglaló 
feladatok legyenek megjelenítve) majd jelenítsük meg 
õket újra!

� A kritikus tevékenységeket a Gantt-féle diagramon 
jelenítsük meg piros csíkokkal (Format|Gantt Chart 
Wizard)!
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1. gyakorlat: A bázisterv elemzése

� Végezzük el a gyakorlatot!

87

ÚTMUTATÓ AZ 2. GYAKORLATHOZ:
A NYOMON KÖVETÉS ELEMZÉSE

� Nyissuk meg a Follow me - Nyomon követés  
2005.febr.22 projektfájlt!

� Vegyük szemre a Gantt-féle diagram csíkjai 
közötti különbséget a febr. 22 dátum elõtt és 
után!

� Nyissuk me a Tracking Gantt nézetet 
(View|Tracking Gantt)!

� Vegyük szemre a késéseket az egyes 
feladatoknál!
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2. gyakorlat: A nyomon követés 
elemzése

� Végezzük el a gyakorlatot!

89

A 3.PÉLDA 

(ÚJ UTAZÁSI PROGRAM 
BEVEZETÉSE)

VÉGE
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Zárószó

� Ez csak a jéghegy csúcsa volt (a szoftver 
számtalan más lehetõséget kínál).
� Az MS Project 2007 megkönnyíti a 

tervezést, de nem tervezhet 
helyettünk.
� Jelentõs erõfeszítésre van szükség a 

szoftver hatékony alkalmazásának 
elsajátításához (tanfolyamok, irodalom, 
gyakorlat). 91

VÉGE AZ III. RÉSZNEK

(EGYSZERÛ MINTA-PROJEKTEK)

92


